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 Two Dog Inventory Software is a very complex and adaptive inventory program.  
Though it initially had several problem areas, which seem to have been mostly solved 
with software upgrades, its broad-based applicability provides an excellent opportunity 
for integrated resource inventory. 
 
 The Two Dog software paperwork you received contains a phone number for 
technical support.  To avoid having several properties calling for technical support for the 
same problem, contact other properties or the C.O. Property Specialist instead to see if 
others are having the same problem.  Another property may already have found a way to 
work around the problem.  If the problem appears to be a software problem, we will make 
one call to tech support to get the solution for everyone.  It is also highly possible that the 
problem could be with the method sets that were created.  The C.O. Property Specialist 
will have to work on these problems. 
 
 Initially the methods were primarily set up as a replacement for the Tally Scheme 
6 inventory method.  This creates some limitations.  As experience with the software has 
grown, so has the opportunity for taking more advantage of the software capabilities, 
thereby improving data analysis.  Feedback from the field users is critical to determine 
which direction this evolution takes. 
 
 Another goal of this is to standardize data collection across all properties.  The 
software has the capability of merging files, so collected information would have to be 
the same configuration to be properly merged. 
 
 The Two Dog manual printed in 2000 is the most recent available.  Retain the 
older 1999 manual as it contains software key and lock information.  The Husky manual 
only covers the Husky hardware, not Two Dog. 
 
OFFICE DOG 
Getting Started 
 When you open Two Dog on the desktop computer, you will notice an opening 
window that contains six tab options – File, Field Data, Reports, Options, Help and Exit.  
You will only be using three of this – File, Field Data, and Reports, to actually create and 
work with your data.  When you eventually decide which reports you wish to have and 
set a default, you will not even have to use the Reports tab. 
 
File Tab 
 The first tab to open is the File tab.  This is where job files are created, transferred 
and changed.  Two options appear – Open or Create File, and Transfer To/From Field 
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Computer.  Job files are files where field data is collected and entered.  These include 
inventories and harvests. 
 

When Open or Create File is selected, the window that opens initially is on the 
Open/New tab.   Three other tab options are Import, Merge and Options.  For now you 
only need to work with Open/New and Options.  The Import tab is for importing data 
from other sources.  The Merge tab is for merging data, and may be useful.  It provides 
the capability of merging two or more job files. 

 
The Open/New tab contains a job list down the left-hand side, a place to create a 

file, and a box that briefly describes the current selected job.  It also has two buttons 
toward the bottom that will allow you to recalculate the data in a job, and print default 
reports without having to go to the Reports tab. 

 
In creating new files, I am requiring the following filename format for tract 

inventory jobs and timber harvest jobs.  The first three digits are the property code, the 
next two digits are the compartment number, and the last two digits are the tract number.  
In addition, I am recommending that a final single letter be used to designate the type of 
information – I for standard inventory, and H for timber harvest tally.  One circumstance 
in which this protocol is not used is when multiple files are created for one job that will 
be merged into a final job file named as above.  There are also some circumstances where 
job files may be created for other purposes, such as an appraisal on a parcel to be 
purchased.  Properties will create job file names that appropriately identify the job. 

 
The Options tab contains the same job list down the left-hand side that the 

Open/New tab had.  It also has a box for setting the method set to be used for a particular, 
selected job.  The only method set option that will be available is Indiana State Forest.  
This new method set will handle inventory and timber harvest tally jobs. 

 
The Transfer To/From Field Computer option opens the screen that is used to 

communicate with the handheld field computer.  The Settings button opens a list of 
settings that allow communication between the desktop computer and the handheld 
computer.  These should already be set by the C.O. Property Specialist.  The Handheld 
Platform should be set to a Husky.  PC Comm Port will be set to Port 1 or Port 2, 
depending on your desktop.  PC Speed will be set to 38,400, the Husky default.  These 
three settings are listed across the bottom of the Transfer window. 

 
Once the handheld computer is set to transfer files with the desktop, the Initialize 

Connection button on the desktop is clicked.  This initiates the communication between 
the desktop and the handheld.  Several windows will open briefly conveying the progress 
of the communication link.  Once the link is established two listings will appear.  On the 
right side is the job file listing from the field computer.  On the left side is the job file 
listing in the desktop computer.  Between the two lists is a window called Select an 
Action.  Two Dog defaults the action to transferring job files.  Clicking the arrow shows a 
drop down list of other available actions such as transferring a volume table or method 



October 11, 2006  Appendix I-D-1 Page 3 

set.  Clicking these other actions will initiate related lists from the desktop computer and 
field computer, making them available for transfer.   

 
Once an Action is selected, the appropriate file on the appropriate list to be 

transferred is highlighted.  This is true whether it is a job file, volume table or method set.  
Then one of the directional arrows in the middle of the window, indicating the direction 
of the transfer, will darken indicating it is enabled.  Clicking the arrow will then 
commence the transfer process.  Some transfers can only occur in one direction.  For 
example, job files can only be transferred from the field computer to the desktop 
computer.  Method sets should only be transferred from the desktop to the field computer.   

 
If a job file of a particular name already exists on the desktop, and a file of the 

same name is attempted to be transferred from the field computer, a window will pop-up 
and ask if the operator wants to overwrite the existing file.  If the two files were intended 
to be different, this protects against eliminating a job file.  In other cases, the transfer file 
from the field computer may be an update of the file on the desktop, so in this case it may 
be appropriate to overwrite the desktop file. 

 
On the Transfer window, the method set listing for the field computer does not 

show the method set, but instead lists the individual methods in the set.  These methods 
are listed with little differentiating description other than the final numerical character.  
They listed as Fielddog.mt1, Fielddog.mt2, Fielddog.mt3, etc.  Because of memory 
limitations, the Husky field computer cannot hold more than one full method set.  If there 
is a method set on the field computer already, and a different method set is to be 
transferred to the field computer, the existing method set needs to be deleted from the 
field computer.  Unlike job files, method files cannot be deleted on the field computer.  It 
can only be done using the Transfer window on the desktop computer.  Under the method 
file listing for the handheld field computer in the Transfer window is a button for deleting 
files from the handheld computer.  Files in the listing are highlighted and the button 
clicked to delete the highlighted files. 

 
 

Field Data Tab 
The Field Data Tab, as the name suggests, is for the field data.  It contains three 

options – Tract Data, Stand Data and Point Data.  Tract in Two Dog is equivalent to our 
tract.  Stand would be a particular stand type within a tract.  For example, mature 
hardwoods may be one stand, pine another stand, and unmerchantable old field may be a 
third stand found within one tract.  This allows separate analysis of each of the stands to 
determine condition and prescription needs.  Properties will break tracts into stands 
where appropriate.  The stands will be based on distinct differences such as timber types 
(oak-hickory, pine, bottomland hardwoods), stand age (mature woods, regenerating old 
field), and use (woods, campground, picnic area, nature preserve).  Each stand must have 
at least two sample points in it in order to be considered a separate stand.  An acreage 
will need to be determined for each stand.  This separation of areas into stands allows 
separate analysis for merchantability, condition, and other features.  
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The only information that you must collect is Point Data, with one exception.  
You can ignore Tract Data and Stand Data, except for acreage.  However, it is strongly 
encouraged that you to at least look at them.  In the future we will be using parts of them, 
and would like recommendations from field staff on which information should become 
the standard to be collected.  Many of the data fields under Tract Data and Stand Data 
either contain drop down lists or allow the creation of drop down lists.  These can be 
customized to meet our system needs.  Whatever is chosen will be the same across all 
properties. 

 
The Tract Data option opens a window from a selected General Tab.  This 

provides a place to insert an ID, which would be the property code, two-digit 
compartment number and three-digit tract number.  A box is available to insert a date.  
Also there is a memo box for text information. 

 
Other available tabs under Tract Data are Owner, Managers, Access, Location and 

Comments.  The Owner Tab is for landowner information.  The Managers Tab is for 
information on the person managing.  The Access Tab may have some utility as it 
provides a description for access to and within a tract.  The Location Tab also has utility 
as it provides location information for a tract.  The Comments Tab provides a box for text 
comments. 

 
The Stand Data option opens a window from a selected General Tab.  This 

provides a place to specify a stand ID.  The stand ID will be the same descriptor as used 
in the tract management guide to describe the stand.  This descriptor can be finalized 
when the tract management guide is completed.  A large box provides a place for a text 
description of the stand. 

 
Other available tabs under Stand Data are Area, Location, Access, Forest Type, 

Site Index, Management, Wildlife, and Comments.  The Area Tab allows the insertion of 
the sample acreage, acreage not sampled and total area.  The entire tract will be sampled 
unless it is not physically possible, such as a lake.  By breaking out areas such as 
campgrounds, or unmerchantable old fields as separate stands, the separate analysis 
available in Two Dog allows keeping the areas separate for analysis, but also combines 
them for a total tract picture.  This tab is where the program gets the acreage for its whole 
stand calculations.  It is the only place in stand data that you must enter information.  The 
Location Tab is very similar to the Location Tab under the Tract Option.  The Access 
Tab describes the access to and within the stand.  The Forest Type Tab may be one of the 
first of these that we use since it allows forest type, structure and other attributes to be 
collected.  The Site Index Tab allows the collection of site index information and other 
site specific attributes.  The site index information is beyond what we do, but the other 
attributes may be useful.  The Management Tab allows the insertion of management 
prescription, guidelines and limitations.  The Wildlife Tab allows the collection of 
wildlife information for the stand.  And lastly there is a Comments Tab for text 
information. 
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The Point Data option is the current area of emphasis for the data collection.  
When this option is selected, the window opens to the Tree Data Tab.  This is the screen 
where our standard tree data is entered.  Other available tabs in this option are Wildife, 
Comments, Plants and Summary. 

 
Tree Data 

On the Tree Data Tab is a spreadsheet area with headings for the entry of tree 
data.  The headings are Number, Species, DBH, Product, MHt and Defect. 

 
The Number field is a numerical identifier for the trees entered on this point.  The 

program automatically inserts it. 
 
The Species field is the species code using the Purdue species abbreviation system 

plus some additional species not covered.  If a box in this field is highlighted, you can 
click the mouse right button to get a drop down list of species.  A warning will flash if the 
program does not recognize a code that is entered.  If a point has no data, but should be 
counted as a sample point (a point in a field for example), enter .N (period and capital N) 
in the species field.  A point can be excluded as a sample point, even if it has data, by 
entering .D (period and capital D) in the species field.  See the manual for more 
information on .N and .D. 

 
The DBH field is the diameter at breast height to the nearest whole inch.  This 

should accept diameters down to one inch.  The program should warn you if the entered 
DBH is outside the specified range for a product (this may depend on the machine). 

 
The Product field is for the two-letter product code.  This is very important 

information because it tells the program what to do with the tree.  The cull and snag 
product classes require completion of information including DBH and height.  These are 
important for some management considerations. 

 
The MHt field is for the merchantable height in logs.  Depending on the product 

code, this log height may be 12 feet or 16 feet.  The Purdue Doyle Volume Table for 12-
foot logs was retained for all sawtimber trees and veneer trees.  The volume unit is board 
feet.  The merchantable height ranges from a half log up to six logs in half log 
increments.  Poles have volume measured in cords, and culls and snags have volume 
measured in cubic feet.  The minimum merchantable height accepted for these is one log.  
Both of these use volume tables with 16-foot logs.  The merchantable height ranges from 
one log to eight logs in half log increments.  The number of logs is entered in the 
merchantable height field numerically as a whole number without a decimal place.  For 
example, a half log is entered as 5, one log is entered as 10, and two and half logs are 
entered as 25. 

 
Cull trees and snag trees are considered to have no merchantable volume, 

therefore they will not accept a defect percentage.  For a harvest, if a snag is to be tallied 
with merchantable volume, it must be treated as a live tree, not a snag.   
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The Defect field is for the percent defect estimated in the tree.  The defect number 
is entered as whole number.  For example, 25 is for 25% defect and 75% sound.   

 
In tallying trees for prime, the following method should be used.  Record the 

prime tree as you would any other tree for Two Dog.  It will be listed in the Two Dog 
totals for volume and number of trees.  In harvests, the tree will be tallied the same way, 
and on notices the volume will be footnoted as “volume in trees with prime volume”. 

 
At the bottom of the Tree Data window are three identifiers.  One identifier is 

Point Number.  The box identifies the point number the tree data is located in.  When 
entering data for a new point, click the Add button and the program will prompt you to 
add a new point number.  If you want to check existing data, you can use the scroll bar to 
move among the points. 

 
Another identifier is the Stand Number.  If we were using stands, we could 

specify that a particular inventory point is in an identified stand.  This option has great 
utility because you can change the stand number or even first assign stand numbers after 
the field information is collected.  Point data can be collected in Field Dog without 
specifying a stand breakdown.  Once the data is downloaded onto the desktop, the point 
data can be brought up and the points can be assigned to various stands in the office. 

 
The last identifier is Method Number.  The new Indiana State Forest method set is 

the only method set available.  This eliminates the need to switch method sets depending 
on whether you are doing harvest tally or inventory, as was the case with the previous 
method sets.  This method set has four methods.  A method set is distinguishable by the 
fact that all methods under it will use similar codes and parameters for species, products 
and other information.  You could identify different methods from the same method set 
for different points in the tally.  For example, if you are converting a pine stand to 
hardwoods using a clear-cut, you could use point sampling to get the volume and tree 
number estimates so you do not have to tally every tree.  If there is a recent blowdown 
area within the stand that you cannot use point sampling on, you can use fixed radius 
plots.  You could then specify which method is used on each point, differentiate the 
points into different stands, assign appropriate stand acreages, and the program would do 
the calculations accordingly. 

 
The first method is a ten-factor prism inventory method.  It can be used for 

standard tract inventories.  It can also be used for harvest tally in some circumstances.  
This could be a case of a homogeneous pine stand that is being removed completely.  
Rather than mark and tally every individual tree, the boundary of the removal can be 
marked, and the harvest area sampled for the sale estimate. 

 
The second method is a tenth-acre fixed radius plot inventory method.  It can be 

used in circumstances when a prism inventory would not suffice.  It can be used for 
harvest tally estimation in circumstances when there is storm damage requiring complete 
removal and there are many downed trees making prism sampling unworkable. 
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The third method is the primary method for harvest tally – 100% tally of 
individual trees.  This can be used in the tally of trees marked for timber sales or timber 
stand improvement.   

 
The fourth method is a twenty-factor prism inventory method.  It is currently not 

for general state forest use.  It is currently being studied for possible applications on the 
state forests. 

 
 
Other Point Data 
 Similar to the Tract Data and Stand Data, it is currently not necessary to collect 
and enter data information in the other tabs under the Point Data option.  However, it is 
recommended to look at them to determine what state forests should be using. 
 
 The Wildlife Tab is essentially the same as the Wildlife Tab under Stand Data, 
but in this case it is tied to a point.  Being on a point basis obviously gives it more utility.  
The Comments Tab is a for text information.  The Plants Tab is for sampling plant layers.  
Since we already do the tree layer, this could be used to add shrub and herbaceous layers.  
It includes drop down lists and places to create our own lists.  The Summary Tab does not 
appear to allow any data entry.  Its use is unknown. 
 
Reports Tab 
 The Reports Tab is the last of the three tabs that you would need to use to enter 
and process your data.  Calculation of results and printing reports is done under this tab.  
As stated above, you can avoid coming to this tab once you have default reports set.  
Calculation and printing can be done by going to the File Tab, choosing the Open/Create 
option, and working in the New/Open Tab window. 
 
 The two options in the Reports Tab are Calculate and Reports.  The Calculate 
option opens a window that shows identified default calculations.  Do not change the 
selected calculations.  An exception to this is if you plan to run reports by the 2-inch 
diameter classes.  If this is the case, the calculation option “Round to 2-Inch Classes for 
Reporting” must be clicked on.  Make sure to calculate the data anytime you enter new 
data or change existing data, otherwise reports you print may be based on old data.  At 
the end of the calculation process is a window that lists, among other things, the name of 
the file being run.  This is a way to ensure the correct file is being run. 
 
 The Report option is organized into folders and subfolders.  If there is a collection 
of reports that you find generally useful, you may set that as your default.  Then for many 
uses you may be able to print directly under the File Tab as described above.  If you 
break a tract into stands, you will need to run stand reports to summarize your stands, and 
tract reports to summarize the entire tract. 
 
 Some of the reports that seemed useful are 
 
• Stand Level Tables W/DBH Classes by 1 
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• Stand and Tract Level Summaries 

• Summary by DBH and Product-Species 
• Stand Summary by Product-Species 

 
• Stand and Tract Level Statistics 

• Stats by Product-Species 
 
 

The Statistics are interesting because they provide a measure of statistical 
confidence for the inventory.   

 
The value calculated on these reports can be used to calculate minimum bids.  The 

total value of the harvest trees would need to be reduced to account for a minimum 
situation and for any other factors affecting sale value.  With typical sales, the calculated 
value would be reduced by ten percent to determine a minimum bid.  Sales with other 
factors such as problem access may require additional adjustments of five or more 
percent. 

 
Options Tab 

The Options Tab has three options, Method Manager, Volume Table Editor, and 
Install Field Dog.  Do not change anything in these.  They are critical to the operation 
of this program.  They will be standardized through the state forest system.  You can look 
at them however.  These are key areas, particularly Method Manager that you should 
review and provide suggestions for changes. 

 
 
The Volume Table Editor option has a long list of volume tables to choose from, 

and has the option of developing a customized table.  The Purdue Doyle Volume Table 
used by state forests has been added to the list of volume tables. 

 
Method Manager 

The Method Manager option is the key to program operation.  Make no changes 
to Method Manager.  Please review it and make recommendations for future changes. 

 
The Method Manager option has a number tabs, only four of which you need to 

be concerned with – Global Settings, Dog Files, Products Setup, and Tree Inventory.  The 
Global Settings Tab shows the job file name at the top, and lists the method set name 
selected.  Then it gives a number of parameters of the method set. 

 
The new method set, Indiana State Forest has four methods, as described above – 

10-factor Point Sampling, tenth-acre Fixed-Radius Plots,  100% Tally, and 20-factor 
Point Sampling,.  The methods have similar prices and products. 

 
The Dog Files Tab contains lists for the whole variety of items in the program.  

By selecting an attribute, you can select from a list of tables for that attribute.  For 



October 11, 2006  Appendix I-D-1 Page 9 

example, if Trees is selected, you can look at a species table, a products table, a crown 
class table and a form class table, among many others.  The tables and lists in the Dog 
Files can be adjusted to meet our needs, based on recommendations. 

 
The Products Setup Tab is where it is decided what to do with the data for a 

particular tree.  This is where it is given a volume and value.  Again recommendations for 
changes are being solicited.  For sawtimber in general, the minimum DBH size is the 14-
inch size class.  Poles are smaller than the 14-inch size class.  All veneer minimum sizes 
are the same as in the manual.  There is a minimum DBH size of 16 inches for the higher-
grade sawtimber (called Quality Sawtimber).  There are no size limits for culls and snags.  
Because there currently is no way to break a prime tree down into prime and sawtimber 
parts, it is recommended that prime log volume for sales be tallied as above.   

 
The Tree Inventory Tab is where the decision is made on what inventory 

information is to be gathered.  Selections are made by moving attributes between the On 
and Off boxes. 

 
 

FIELD DOG 
Field Computer 
 The Husky MP2500 is a rugged handheld field computer.  It is designed, when 
installed with Field Dog, to allow for the collection of information in the field under 
varied weather conditions.  It is designed to withstand some of the rough handling that 
would occur with field use, but it is not indestructible.  After the data is collected, it can 
be downloaded directly into the desktop computer to generate reports. 
 
 The Husky manual is the reference for this machine.  Key elements in the manual 
discuss the power supply, handling and care of the unit.  The manual also has a section 
for trouble shooting.  Among the important sections is information on batteries, hard 
reset, and rebooting. 

 
Of particular note, properties should always take a set of alkaline batteries with 

the yellow plastic battery tube in the field when using the Husky in case the rechargeable 
battery pack runs low.  Never open the spring-loaded battery cover in a location (such as 
in the woods) where it can be readily lost.  Make sure that when recharging, the only 
battery recharged with the supplied charger is the Husky battery stick.  If other brand 
rechargeable batteries are used, recharge them in a charger designed for those batteries.  
Do not recharge alkaline batteries.   

 
The red (power) key on the Husky keypad turns the computer on and off.  The 

Husky will also shut down automatically if unused after a few minutes.  When turned 
back on, the opening screen will be the last screen showing when it turned off. 

 
On some occasions when batteries run down or the field computer sits off for a 

long period of time it will go into mode in which a normal power button activation will 
not be able to start the computer.  In these cases a hard reset needs to be done.  This is 
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done by holding down the Escape button, the up-arrow, and the power button at the same 
time for about five seconds. 
 
Software 
 In basic mode, the Husky will provide a prompt C:\> and states to type FD for 
FieldDog.  Typing FD and pressing Enter will initiate Field Dog.  There is no reason to 
move back out of Field Dog.  At the Field Dog opening screen, pressing Enter will cause 
the File Menu to appear.  The software operates similar to early DOS desktop PC 
programs by providing options to select and using Function keys.  Options can be 
selected by scrolling down to the desired option and hitting Enter, or by hitting the 
number of the option. 

 
File Menu 
 The first option under File Menu is New Filename.  This is for creating a new job 
file, either inventory or harvest.  When selected, the Filename Selection screen appears 
and a new filename is requested.  Use the same filename parameters as described above.  
When the filename is set and Enter is hit, several screens will show in progression.  First 
the screen will state it is creating the file.  Since there is more than one method in the 
Indiana State Forest method set, the screen will display the available methods and ask 
which method the file is to be created with.  A method from the list must be selected.  
The names for the different methods that appear on the Husky unit are not very 
descriptive, with the only differentiation being the final numerical character.  Remember 
the following: 
   Fielddog.mt1 is 10-factor prism point sampling, 
   Fielddog.mt2 is tenth acre fixed acre plot sampling,  
   Fielddog.mt3 is 100% tally 
 And Fielddog.mt4 is 20-factor prism point sampling. 
 
 Once the method is loaded and the file is created, the screen will return to 
Filename Selection : Enter Filename: (filename).  Select OK (press F1) if you are done 
creating files.  The File Menu screen will return.  If you are ready to enter data into the 
new file you can select OK (press F1), which will bring up the main Menu screen. 
 
 The second option under File Menu is Open Existing File.  This is for opening an 
already existing job file.  When it is selected a filename list will appear to select from.  If 
there are no job files in memory, a message to that effect will be displayed.  When an 
existing file is selected, a Loading Methods message will appear.  When done opening, 
the screen will return to the File Menu.  If you are ready to enter data into the opened file, 
select OK (press F1), which will bring up the Main Menu screen. 
 
 The third option under File Menu is Transfer File.  This is for communicating 
with the desktop computer, and transferring volume table files, method files, and job 
files. 
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 The fourth option under File Menu is Compress File.  It is described in the manual 
as compressing files for completed jobs.  Before anyone tries this with a critical file, it is 
recommended that it be tried on test files first. 
 
 The fifth option under File Menu is Delete File.  This option allows the deletion 
of job files.  Method files and volume table files cannot be deleted under this option. 
 
 The sixth and final option under File Menu is System Info.  Selection of this 
brings up a screen with options for Disk Space, Battery Life, and Serial Number. 
 
Main Menu 
 In the File Menu screen, if OK is selected (press F1), the Main Menu screen will 
appear.  If a job file has been opened or created, its name will appear in the top line. 
 
 The first option in Main Menu is File Menu.  Selecting this will return the screen 
back to the File Menu screen. 
 
 The second option in Main Menu is Tract Data.  This is similar to Tract Data in 
Office Dog on the desktop computer.  Selecting this brings up a screen that gives five 
options (Owner, Access, Location, Managers, Comments) that can be opened for 
information collection. 
 
 The third option in Main Menu is Stand Data.  This is similar to Stand Data in 
Office Dog on the desktop computer.  Selecting this brings up a screen that gives nine 
options (Change Stand, Area, Access, Location, Forest, Site Index, Wildlife, 
Management, Comments) that can be opened for information.  Similar to the desktop, 
Area must be opened and acreage entered in order for Two Dog to do the proper 
calculations.  If calculations are not to be done on the field computer, this can be entered 
later to the job on the desktop computer. 
 
 The fourth option in Main Menu is Point Data.  This is similar to Point Data in 
Office Dog on the Desktop.  Selecting this brings up several options.  The top line on the 
screen displays the point and stand numbers.  The Chg Pt (Change Point) option is for 
changing to a different point number.  The Trees option is for entering tree data such as 
species, DBH and height.  The Plants option is for entering information on the plant 
communities.  The Wildlife option is for entering data about wildlife indicators.  The 
Comments option is self-explanatory. 
 
 In the Trees option under Point Data, the change from point to point can be done 
in two ways.  F1 can be used to back out of the Tree data screen and get to the Point Data 
options screen.  Chg Pt (Change Point) can then be selected.  This brings up a screen to 
select the next point number.  The stand number for that point can also be selected (for 
example if going from hardwoods into a pine stand).  This would be used if doing 
nonsequential point numbers. 
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 The easier method if using sequential point numbers is available on the Tree data 
screen.  The lower line of white letters on black give several options for the F keys.  F4 
will set up the next sequential point number, ready for data entry.  The stand number will 
be the same as the previous point.  The F3 key will bring up the previous point data, 
which can be added to or corrected.  If desired, the assignment of points to a stand can be 
done in the office on Office Dog after all field data is collected and downloaded. 
 
 The fifth option in Main Menu is Calculate.  This will calculate very basic 
information and statistics.  
 
 The sixth option in Main Menu is Setup Menu.  This is for making changes in the 
settings and method.  This should not be changed as it can affect data. 
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Indiana State Forest Method Set 
Product list      
VL Veneer (prime) leave   VH Veneer (prime) harvest  
SL Sawtimber leave   SH Sawtimber harvest 
QL Quality Sawtimber leave  QH Quality Sawtimber harvest 
PL Poles leave    PH Pole harvest 
CL Cull leave    CH Cull harvest 
NL Snag leave    NH Snag harvest 
AL Sapling leave    AH Sapling harvest 
 
 
Veneer trees is a misnomer.  The term veneer here is really for the designation of prime 
trees, per the stated grading guide. 
 
Sawtimber trees are those trees in the 12-inch diameter class and larger that are 
considered to have merchantable sawtimber volume. 
 
Quality sawtimber trees are those sawtimber trees in species that have prime designations 
that do not quite meet the prime designation, and similar or better trees in those species 
without a prime option. 
 
Culls are defined as live trees with no merchantable volume.  Generally their designation 
for removal in a harvest is in order for the harvest operation to perform some of the TSI.  
Poles can be considered culls when they are determined to have essentially no sound 
volume. 
 
Snags are defined as standing, dead trees.  These can be sawtimber size or pole size. 
 
Volume in culls and snags is in cubic feet.  There is value in identifying this “lost” 
volume.  Cubic foot measure is a way to keep it separated from sawtimber.  If a snag 
needs to be tallied with merchantable volume, it must be treated as a live tree. 
 
Poles are considered to have no merchantable sawtimber volume.  They are trees in the 6-
inch diameter class to the 11-inch diameter class.  Volume in poles in calculated in cords.  
Poles with defect that destroys their volume should be considered culls.   
 
Saplings are smaller than the poles but large enough to have DBH.  They are not assigned 
a volume. 
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Species List and Codes for All Method Sets 
 
BLO Black Oak   BLG Blackgum   EAH Eastern Hemlock 
REO Northern Red Oak  SWG Sweetgum   BLS Black Spruce 
SCO Scarlet Oak   LAA Largetooth Aspen  WHS White Spruce 
BJO Blackjack Oak   QUA Quaking Aspen  NOS Norway Spruce 
NPO Northern Pin Oak  COT Eastern Cottonwood  TAM Tamarack 
PIO Pin Oak   BAP Balsam Poplar   OTC Other Conifers 
SHO Shingle Oak   COF Kentucky Coffeetree  WIE Winged Elm 
ZSO Shumard Oak   SYC American Sycamore  ZYB Yellow Buckeye 
CBO Cherrybark Oak  SAS Sassafras    
ORO Other Red Oak  PER Persimmon    
WHO White Oak   PAB Paper Birch 
CHO Chestnut Oak   RIB River Birch 
ZCO Chinkapin Oak  YEB Yellow Birch 
BUO Bur Oak   OHB Ohio Buckeye 
POO Post Oak   CAT Catalpa 
SWO Swamp White Oak  BLL Black Locust 
XSO Swamp Chestnut Oak  HOL Honeylocust 
OWO Other White Oak  ZBW Black Willow 
BIH Bitternut Hickory  OSO Osage-orange  
MOH Mockernut Hickory  DOG Dogwood 
PIH Pignut Hickory  REB Redbud 
SHH Shagbark Hickory  PAP Paw Paw 
ZSH Shellbark Hickory  ZRM Red Mulberry 
PEC Pecan    IRO Ironwood 
SUM Sugar Maple   HAW Hawthorn 
REM Red Maple   BLB Bluebeech 
SIM Silver Maple   AIL Ailanthus 
BOX Boxelder   PAU Paulownia 
YEP Yellow-poplar   YEL Yellowwood 
CUC Cucumbertree   OTH Other Hardwoods 
BLA Black Ash   JAP Jack Pine 
ZBA Blue Ash   LOP Loblolly Pine 
GRA Green Ash   PIP Pitch Pine 
WHA White Ash   REP Red Pine 
BLW Black Walnut   SCP Scots Pine 
BUT Butternut   SHP Shortleaf Pine 
BLC Black Cherry   VIP Virginia Pine 
AME American Elm   WHP Eastern White Pine 
REE Red Elm   OTP Other Pine 
ROE Rock Elm   ERC Eastern Redcedar 
HAC Hackberry   NWC Northern White-cedar 
AMB American Beech  BAC Baldcypress 
BAS Basswood   BAF Balsam Fir 
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